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Chapter 1: Introduction

Read this section for an introduction to the
mimio Studio software and basic
terminology.

1.1. What is mimio Studio?

mimio Studio is a suite of software tools that allow you to capture, create, and present information. When
used with mimio hardware and a data projector, mimio Studio turns any whiteboard into a powerful
interactive presentation tool. Without a projector, mimio Studio records handwritten notes and drawings
directly from your mimio enabled whiteboard. Without mimio hardware, mimio Studio can be used to
prepare presentations and manipulate previously created content.

1.2. Important Terminology

Recording Mode — mimio Studio is being used to record notes and drawings from your whiteboard. In
this mode, the mimio hardware is being used without a data projector. The mimio stylus pens are used
with dry erase markers to write and the mimio eraser is used to erase.

Interactive Mode — mimio Studio is being used to control, interact, and annotate the Windows Desktop
and its applications. In this mode, the mimio hardware is being used with a data projector. The mimio
Mouse (or a mimio Stylus with a mimioMouse insert) is used as a virtual mouse to manipulate images
and text projected on the whiteboard.

Digital Ink — Data captured during the Recording Mode.

1.3. Minimum system requirements

The minimum system requirements for mimio Studio are:

e  Windows® Compatible PC with a Pentium II, 400 MHz processor minimum.
e Microsoft Windows 98SE, Me, 2000, XP, or Vista operating system.

e 64 MB RAM minimum (128 MB RAM recommended).

e 45 MB free disk space.
e CD-ROM drive or internet connection to download the software installer.
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Chapter 2: Overview

Read this section to learn about the

general features of the mimio Tools,

mimio Notebook, and mimio Studio
= Settings.

2.1. Overview of the mimio Tools

The mimio Tools provide a comprehensive set of interactive tools and resources to create and present
information. The mimio Tools are used for modifying mimio Notebooks and for screen annotation. The

mimio Tools have two modes of operation, a fully expanded view, for easy access to all features, and a

compressed view, which takes up less space on the screen.

To access the mimio Tools:

Do one of the following:

Double-Click the mimio Tools icon on the Desktop.
Right-click mimio %/ in the notification area of the Taskbar and select mimio Tools.

[E] mimio Motebook
2 mimio Taols
] mimio Recorder

Settings
Help

_J Exit
<3

From the mimio Notebook, do one of the following.

o Double-Click mimio Tools Ed.

o Select Tools from the menu and click mimio Tools .

Click Start Menu, click All Programs, click mimio, and select mimio Tools.

@ Set Program Access and Defaults
W Windows Catalng
& windows Update

I Accessories 4

All Programs | DG RERaT 4

@ mimio »| B mimio Nobsbook k
) Morton Antivirus | B mimio Tooks
,'; start '@ @ Tnternet Explarer [E}, mimio Recorder

(Interactive Mode only) Press the New Page "&2" button on your mimio device.
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To compress the mimio Tools:

Click Compress Window J& on the mimio Tools.

To expand the mimio Tools:

Click Expand Window I on the mimio Tools.

To access tools when the mimio Tools are compressed:

1.

Click the arrow next to Expand Window I on the mimio Tools.

2. Navigate through the menu to select tools and adjust properties.

2.2. Overview of the mimio Notebook

The mimio Notebook allows you to create and present information. Using mimio Notebook is very
similar to using other word processing or presentation applications. Content created in mimio
Notebooks can be saved as native mimio INK files or exported to a variety of other file formats including
HTML, JPEG, PNG, GIF, BMP, TIFF, and PDF.

To open a mimio Notebook:

Do one of the following:

Double-Click the mimio Notebook icon on the Desktop.
Right-click mimio %/ in the notification area of the Taskbar and select mimio Notebook.

1E] mimio Nokebaok
2 mimio Tooks
[E1 mimio Recorder

Settings
Help

[0 B

=

Click Start Menu, click All Programs, click mimio, and select mimio Notebook.

@  Set Program Access and Defauls

®% windows Catalog
% windows Update

I Accessories

allprograms B | Bl gT]
I Morton Antivirus | & mimia Taols
o & Internet Explorer [x} mimio Recorder

Double-Click the icon for a previously saved mimio Notebook file.

2.3. Overview of the mimio Recorder

The mimio Recorder provides a set of tools used to record your mimio interactions into a movie (AVI) file

with the option to record audio, using a microphone, as well.

To open the Recorder:

Do one of the following:

Double-Click the mimio Recorder icon on the Desktop.

Overview 3



Right-click mimio %/ in the notification area of the Taskbar and select mimio Recorder.

1] mimio Mokebook
2 mimio Tools
[E1 mimio Recorder

Settings

Help

2] Exit

Click Start Menu, click All Programs, click mimio, and select mimio Recorder.

@ Set Program Access and Defaults

&% Windows Catalog

W windows Update

I Accessories »
I Startup 3
fG mimio » | B mimia Hotebook
1) Mortan Antivirus »
S| @ Tnbermet Explorer

All Programs B

[, mimia Taoks

[E), mimio Recorder

Open the mimio Tools and click Recorder ==

24. Overview of the mimio Studio Settings

The mimio Studio Settings contain options for setting and customizing the properties and characteristics
for your mimio system, including Pens, Devices, Software Updates, Interactive, NetMeeting, and mimio
Notebook options.

To access the mimio Studio Settings:

Do one of the following:

Right-click mimio %7 in the notification area of the Taskbar and select mimio Studio Settings.

1] mimio Motebook
] wimio Taols
= mimio Recorder

Settings

Help

T
From the mimio Notebook, do one of the following.

o Double-Click Settings A ]
o Click Tools and select mimio Studio Settings.

Overview



Chapter 3: Setting up your mimio

Read this section to learn how to setup
your mimio hardware.

3.1. Installing mimio hardware

This section will guide you through the process of setting up your mimio Interactive, mimio Capture
(mimio Xi), mimio wireless, mimioBoard, or simply replacing a battery in your mimio Mouse or one of
the mimio Stylus pens.

To setup your mimio Xi:
1. Unfold the mimio Xi.

2. Plug the included mini-USB cable into the socket on the bottom recessed end of the mimio Xi.

Setting up your mimio



3. Attach the mimio Xi to your whiteboard or other writing surface, using one of the following:
e For periods of extended use or repeated use in any location, attach the mimio Xi using the

mounting brackets:
a. Snap the mounting brackets over the suction cups, making sure they clip into the recesses on

the edges of the mimio Xi.

b. Carefully peel the backing from the adhesive strips.
c.  Mount the mimio Xi by pressing the bar, with mounting bracket in place, in the upper left-
hand corner of your whiteboard.

e For short periods of use, attach the mimio Xi using the suction cups.
a. Clean the surface of the whiteboard with a damp cloth.
b. Press the mimio Xi in the upper left-hand corner of your whiteboard.

Setting up your mimio



4. Plug the other end of the USB cable into your PC USB port. The capture bar should be automatically
detected by the PC and the mimio Studio software. Refer to your system documentation if you can't
find the USB port, or if your capture bar is not automatically detected.

To run mimio Xi using battery power:

(Not required when using a USB connection.)
1. Remove the battery cover on the rear of your mimio Xi.

2.

Setting up your mimio



3. Put the battery cover back on.

To run mimio Xi using wall power:

(Not required when using a USB connection.)
1. Plug the wall adapter into the bottom recessed end of the mimio Xi.

Setting up your mimio



2. Plug the wall adapter into a wall socket.

To setup your mimio wireless:

1. Depress the release button and slide the module downwards to remove the linkUSB module from the
mimio Xi.

2. Insert/slide the wireless module into the mimio Xi.

3. Power the mimio Xi using batteries or a wall power supply.

Setting up your mimio 9



Mount the mimio Xi on your whiteboard as before.

S

If using battery power, press the Power €@ putton until it turns green.

6. Do one of the following:

e If your receiver has an integrated USB end, plug the receiver module into one of the available
USB ports on your PC. In some cases in may be necessary to use the supplied USB extension
cable. The capture bar should be automatically detected. Refer to your system documentation if
you can't find the USB port, or if the capture bar is not automatically detected.

e If your receiver does not have an integrated USB end, do the following:
1. Connect the 12” receiver USB cable to the wireless receiver.

\C

2. Plug the other end of the USB cable into your PC USB port. The capture bar should be
automatically detected. Refer to your system documentation if you can't find the USB port, or
if your capture bar is not automatically detected.

Setting up your mimio 10



To setup your mimioBoard:

1. Plug the included mimio USB cable into the socket on the side of the mimioBoard.

2. Plug the other end of the USB cable into your PC USB port. The capture bar should be automatically
detected. Refer to your system documentation if you can't find the USB port, or if your capture bar is

not automatically detected.

To setup your mimio Mouse:

1. Remove the battery cover by lightly pressing down and pushing the cover back away from the mimio

Mouse tip.

\J

2. Insert AA battery.

Setting up your mimio
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3. Put the battery cover back on by gliding the cover back into place.

To setup your mimio Stylus pens:
4. Remove the end of the stylus by gently twisting and pulling.

5. Remove the colored cap by pressing on the colored nodes and pulling.

" 4

6. Insert N-Cell battery.

@4—@

7. Put the colored cap back on by snapping it into place.

b 4

“

Setting up your mimio
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8. Do one of the following;
a. To use the stylus to record digital ink, insert an Expo Marker into the stylus.

1
1

b. To use the stylus interactively, inset the mimioMouse insert into the stylus.

|
/'l

|
7

9. Put the stylus back together by pushing and twisting.

To setup your mimio Eraser:

(Not used in the Interactive Mode.)
1. Remove the eraser cover by lightly pressing on the sides of the eraser in while lifting.

Setting up your mimio
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2. Insert AAA battery.

S

3. Put the eraser back together.

@3

3.2. Adjusting pen settings

The Pen Settings allow you to change the width and color assignment for mimio stylus pens. You must

have a mimio plugged into your PC to adjust pen settings. These settings are only used when your
mimio device is used to record digital ink.

To access the Pen Settings:

1. Open the mimio Studio Settings.
2. Click Pens #”.

B mimio Studio Settings &‘

[E] mimio Notebook
] mimin Recorder

) Devices

I8 Interactive

& Nethesting

# Pens

% Soflware Updale

Pen Pen twiidth

 Black Siylus 0 in
/|

A Girsen Stylus Pen Color
A Blue Stylus EEEEEENEEN

;grownﬁ;_\ilt;s EEEEEE NN
ange Silus EEEEEECN
# Purple Stylus EEEE
& ellow Stylus
Delauls

To adjust the pen properties:

1. Select the pen to adjust from the Pens list.

2. To adjust the pen thickness, do one of the following:
e Drag the Pen Width slider.
o Enter a value into the Pen Width field.

3. To adjust the pen color, do one of the following:

Setting up your mimio
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a. To use any of the default colors, click on any color in the Color Palette.

b. To use additional colors, click More Colors.
4. Click OK or APPLY to save the changes.

3.3. Adjusting the settings for a device

The Device Settings allow you to change the surface size and mounting style for connected mimio
devices.

To access the Device Settings:

1. Open the mimio Studio Settings.
2. Click Devices '/

B mimio Studio Settings E‘

[E] mirmio Motebook
Frecorder il
I8 Interacive

& Nethesting

Pens
5 Software Update

Device:
rimio =i (BC9BDCO01)

Surface Size Device Mounting

96" % 48" v Yertical - Top Left v
Mdiclth: in

Height: in

To adjust surface size for a device:

(Not available for mimioBoard users.)

1. Click the Device dropdown and choose the device you wish to adjust.

2. To adjust the size, do one of the following:

e To choose a default size, click the Surface Size dropdown and choose one of the available sizes.

To choose a custom size, click the Surface Size dropdown, choose Custom, and enter the desired
valued into the Width and Height fields.

To automatically set a size, click Auto Size and touch any mimio Stylus pen at the targeted

location.
Auto Size E‘
D
Click an the target with any stulus to resize your capture area.

3. Click OK or APPLY to save the changes.
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To adjust the mounting location for a device:

(Not available for mimioBoard users.)
1. Click the Device Mounting dropdown and choose the desired mounting style:
a. Vertical — Top Left — the mimio is mounted vertically and aligned with the top left corner of the
whiteboard (maximum size is 4’ tall x 8’ wide).

[

b. Vertical — Bottom Left — the mimio is mounted vertically and aligned with the bottom left corner
of the whiteboard (maximum size is 4’ tall x 8 wide).

[

c. Vertical — Top Right — the mimio is mounted vertically and aligned with the top right corner of
the whiteboard (maximum size is 4’ tall x 8 wide).

d. Vertical — Bottom Right — the mimio is mounted vertically and aligned with the bottom right
corner of the whiteboard (maximum size is 4’ tall x 8 wide).

| — v\*‘n"ﬂ)
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e. Horizontal — Top Left — the mimio is mounted horizontally and aligned with the top left corner of
the whiteboard (maximum size is 8 tall x 4" wide).

[ o0 ——.

f. Horizontal — Top Right — the mimio is mounted horizontally and aligned with the top right
corner of the whiteboard (maximum size is 8’ tall x 4" wide).

o ———

g. Horizontal — Bottom Left — the mimio is mounted horizontally and aligned with the bottom left
corner of the whiteboard (maximum size is 8’ tall x 4" wide).

ey

h. Horizontal — Bottom Right — the mimio is mounted horizontally and aligned with the bottom
right corner of the whiteboard (maximum size is 8 tall x 4" wide).

ey
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i. Fixed - the mimio is fixed to the whiteboard and can not be moved.

2. Click OK or APPLY to save the changes.

To access device specific settings:
Click Settings.

To create a combined surface:

1. Connect two or more mimio devices.
2. Resize the surfaces for the mimio devices.
3. Click Combine.

Create extended surface g|
Follow the steps outiined below to create an extended surface.

Step1

Make sure that all the devices pou wish to combing into an extened surface have

the correct suface size

Step 2

Select the pe of exterded surface you would ke to create from the list below
Evended Surace Syies: v

Step 3

Push the "Mew Page' button on the device attached ta the suiface shown below,

Step 4
Enter a name for vour extended surface and click OK.

Extened Surface Name

4. Click the Extend Surface Styles dropdown and select the arrangement of your combined surface.

5. Click New Page ¥&D on each mimio device in the order shown.
6. Enter a name for your extended surface in the Extend surface Name field.

Setting up your mimio
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Chapter 4: Interactive Whiteboard

Read this section to learn how to begin
interacting with your Windows Desktop
using a mimio stylus as a mouse.

4.1. Using the Interactive Mode

A projector, combined with a mimio capture device, can be a powerful tool for interactive presentations.

To setup the Interactive Mode:

1. Project your Desktop image onto the whiteboard. Make sure that the projected image is positioned
such that there is a 2-3” buffer between the edges of your projection and your mimio.

2. (optional for systems without a mimio Mouse) Place the plastic mimioMouse insert into any one of the
stylus pens.

Interactive Whiteboard 19



3. Do one of the following;:
e Start the mimio Tools and click Interactive ‘&,
e Press the Interactive ‘@& button on your mimio device.
e Open the mimio Studio settings, select Interactive Settings, and click Enable.
o (optional for systems with a mimio Mouse) Click the mimio Mouse anywhere on the whiteboard.

Press stylus on the center of each calibration point.
Press <Enter> on your keyhoard to switch display monitors.

Press <Esc> on your keyboard to exit calibration.

4. (optional for systems with multiple displays) Press the ENTER to switch between displays until the
desired projector display is selected.

5. While holding the mimio stylus pen perpendicular to the writing surface; click the interactive stylus
down at the center of each calibration target. The previous calibration target will disappear and the
next calibration target will appear. The calibration screen will disappear once you have done this nine
times, and you will enter Interactive Mode.

To exit the Interactive Mode:
Do one of the following:

e Start the mimio Tools, click Interactive & and select Exit.

Interactive Hode

Do wou wizh to exit from interactive mode or recalibrate?

i E xit i [Eecalibrate] [ Cancel ]

e Press the Interactive @ button twice on your mimio device.
¢ Open the mimio Settings, select Interactive, and click Disable.

To recalibrate the Interactive Mode:
Do one of the following:
e  Start the mimio Tools, click Interactive I and select Recalibrate.

Interactive Hode

Do wou wigh to exit from interactive mode o recalibrate?

- Emt [Eecalibrate] [ Cancel
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o Press the Interactive ' button on your mimio device.
e Open the mimio Settings, select Interactive, and click Calibrate.

4.2. Using the pen as a mouse

When in the Interactive Mode, the mimio Mouse (or any mimio Stylus with a mimioMosue insert) can be
used as a mouse to control your Desktop or interact with applications.

To execute a left mouse click:
Click in the projected area at the desired location with the tip of the pen.

To execute a double left mouse click:
Quickly click in the projected area at the desired location with the tip of the pen twice.

To execute a right mouse click:

Do one of the following:
e If you have a mimio Mouse, do the following;
1. Move the mimio Mouse to the desired location, staying as close as possible to the whiteboard,
without actually touching it.
2. Click the Right-click b= (back) button on the mimio Mouse.
e If you have a mimio Stylus with a mimio Mouse insert, do the following:
1. Start the mimio Tools.
2. Click Right Click @ icon.
3. Click in the projected area at the desired location with the mimio Stylus pen.

To hover the mouse:

Do one of the following:
e If you have a mimio Mouse, do the following;:
1. Hold the mimio Mouse as close as possible to the whiteboard, without actually touching it.
2. Press the Hover Q (front) button.
3. Move the mouse to the desired location with the mimio Mouse.
4. Release the Hover Q (front) button.
e If you have a mimio Stylus with a mimio Mouse insert, then this feature is not available.

4.3. Annotating the screen

The Screen Markup Mode allows you to annotate applications, web pages, images, etc. When in Screen
Markup Mode a green border with a faded edge will appear around your Windows Desktop.

To enter Screen Markup Mode:

Do one of the following:
e To enter from the mimio Tools, do the following:
1. Start the mimio Tools.
2. Click Screen Markup ™ to “freeze” whatever screen or application you are in.
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3. Annotate the frozen screen with the mimio Tools. All object drawing and manipulation features

in the mimio Tools are available during screen annotation.
o (Interactive Mode only) Press the Copy Page & button on the mimio device.

To exit Screen Markup Mode:

Do one of the following:

e To exit from the mimio Tools, click Mouse ®] to “unfreeze” the screen. All annotations are

automatically archived for later use in the mimio Markups.
o (Interactive Mode only) Press the Copy Page & button on the mimio device.

To disable the Screen Markup Mode border:

1. Open the mimio Studio Settings.
2. Click mimio Tools .

] mimio Matebaak Screen Markup

.

mimio ;U“'S . [1iE FablE scisen malkunborden
mirnio Recarder

] Devices

I8 Interactive

& NetMesting
Pens

% Software Update

B mimio Studio Settings @

[ ok [ concal | [ appy | [ Hep | [ About |

3. Uncheck Enable screen markup border.

4. Click OK or APPLY to save.

4.4. Using the Spotlight Tool

The Spotlight Tool B masks the entire screen except for a small region: the "spotlight". This allows
presenters to focus the audience’s attention on a specific region of the screen. The “spotlight” can be
reshaped, resized, and moved around the screen.

To activate the Spotlight Tool:

Do one of the following:

e To launch from the mimio Tools, do the following:

1. Start the mimio Tools.
2. Click Spotlight .

e (Interactive Mode only) Press the Print Page '@ button on the mimio device.

Interactive Whiteboard
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To exit the Spotlight Tool:

Do one of the following:
e Click Close . o
o (Interactive Mode only) Press the Print Page & button on the mimio device.

To adjust the location of the spotlight:
Drag on the shaded area outside of the spotlight's border.

To adjust the transparency of the Spotlight Tool:
1. Click Spotlight Menu E.

Transparency

2. Select the Transparency entry in the menu to see the transparency options.
3. Select the new transparency from the list.

A transparency of “0%” means that the shaded area will be completely opaque — you will not be able to
see through the area around the spotlight at all.

Please note that Windows 98 does not support transparency, and so the Transparency submenu in the
Spotlight menu will be grayed out on PCs running the Windows 98 operating system.

Interactive Whiteboard
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To adjust the shape of the Spotlight Tool:
1. Click Spotlight Menu a.

Shape 4 v Circle
Size » Sguare

Transparent # Rounded Rectangle

i Star
Exit

2. Select Shape in the menu to see a list of possible spotlight shapes.
3. Choose the new shape.

To adjust the size of the Spotlight Tool:

By doing one of the following:
e To choose one of the default sizes:
1. Click Spotlight Menu a8

Smallest
Transparency *| w Smaller

i Medium
Exit

Larger
Largest

2. Select Size from the menu. You will see a list of spotlight sizes, defined in relative terms from
"Smallest" to "Largest".
3. Select the new spotlight size from the list.
e To choose a custom size, drag the colored border of the spotlight.

4.5. Using the Reveal Tool

The Reveal Tool = creates a “shade” that can be raised or lowered over the contents of the screen, as if
you are moving a shade up or down from the bottom of the screen. This allows presenters to expose
bullet points or other information in a progressive fashion.

To activate the Reveal Tool:

Do one of the following:

e To launch from the mimio Tools, do the following:
1. Start the mimio Tools.
2. Click Reveal I,

e (Interactive Mode only) Press the Minimize/Maximize Window & button on the mimio device.

Interactive Whiteboard
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Qeak - © - [x] [B] @ POseath Jpraorns @rveda €3 (- i @ - [ ) B
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mixed numbers
+ Dividing P
mixed numbers HINT:

To exit the Reveal Tool:

Do one of the following:
e Click Close k3.
o (Interactive Mode only) Press the Minimize/Maximize Window &P button on the mimio device.

To adjust the revealed area:
Click and drag Reveal Tool's shaded area.

To adjust the transparency of the Reveal Tool:
1. Click Reveal Menu El.

Transparency » YT

Exit

2. Select the Transparency entry in the menu to see the transparency options.
3. Select the new transparency from the list.

A transparency of “0%” means that the shaded area will be completely opaque — you will not be able to
see through the Reveal Tool's shade at all.

Windows 98 does not support transparency, and so the Transparency submenu in the Reveal menu will
be grayed out on PCs running the Windows 98 operating system.
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4.6. Using the Web Browser Tool

The Web Browser Tool is a shortcut intended to make it easier to open an Internet browser from within
mimio Studio.

To activate the Web Browser Tool:

1. Start the mimio Tools.
2. Click Web Browser .

4.7. Adjusting the Interactive Settings

The Interactive Settings permit you to calibrate or enable (if calibration has already been done) and adjust
the use of previously calibrated settings.

To access the Interactive Settings:

1. Open the mimio Studio Settings.
2. Click Interactive “®.

B mimio Studio Settings SJ

] mimio Notebook General
mimio Toolks

B mimio Riecorder
I Dievices [JAutomatically enable when a devi
B Interactiva

& Netheeting

[ Use previous calibratian.

Actions and Commands

Pens Action: mirnio Mouse - '4' Button v

55 Softwars Update
Function: | Mouse: Hover v

Calibiate | [ Disable | [ Dsfauls

0K }[ Cancel ][ Apply ][ Help ][ About

To setup the Interactive Mode for a permanent installation:
1. Open the mimio Studio Settings.

2. Click Interactive “®.
3. Check Use previously calibrated settings.
4. Click OK or APPLY to save.

To automatically start Interactive Mode when a mimio is connected to your PC:

1. Open the mimio Studio Settings.

2. Click Interactive “®.

3. Check Automatically start Interactive mode on device connect.
4. Click OK or APPLY to save.

To customize the function of a button on your mimio Mouse or device:

1. Open the mimio Studio Settings.
2. Click Interactive @
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3. Select the action you wish to customize from the Action dropdown menu.
4. Select the function you wish to assign to the action from the Function dropdown menu.
5. Click OK or APPLY to save.

Interactive Whiteboard
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Chapter 5: Recording Digital Ink

Read this section to learn how to begin
recording digital ink using the mimio styli
and erasers.

5.1. Using the Recording Mode

The mimio hardware can be used, without a data projector, to record notes and drawings from the
whiteboard.

To setup the Ink Recording Mode:

1. Place the Expo markers into each of the mimio Stylus pens.

/|

v | WV
N4

2. Setup the mimio Notebook for recording digital ink, by doing one of the following:

e If the mimio Notebook is configured for the Recording Mode (default), do one of the following:
o Open a new notebook and your mimio will automatically connect.
o Start drawing on your whiteboard with any mimio Stylus pen and a new mimio Notebook

will automatically open and begin recording.

e If the mimio Notebook is configured for the Interactive Mode, do the following:
a. Open a new mimio Notebook.
b. Click File, select Connect, and choose one of the available devices to connect to.

5.2. Capturing and erasing digital ink

When using the Recording Mode the mimio Stylus pens and erasers can be used to draw and erase ink on
the whiteboard.
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To draw ink:

1. Chose one of the colored mimio Stylus pens, depending on what color you wish to use. Regardless
of the color of ink inserted, the color on the computer will match the color of the end cap.

2. Drag the stylus across the whiteboard. To make sure the data is accurately captured, make sure to
the keep the stylus within 15 degrees of its perpendicular position with the whiteboard.

To erase Ink:

1. Choose the small or larger eraser.

Small Eraser

Large Eraser
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2. Drag the eraser across the whiteboard. To make sure the data is accurately erased, make sure to the
keep the eraser flat against the whiteboard.

5.3. Using the hardware buttons

When using the Recording Mode the mimio hardware buttons can be used to easily access features
directly from your whiteboard.

w & New Page
& Copy Page

@ Print Page

«=» Maximize/Minimize Window

@ === Interactive

D S —
- -

To insert new pages:
Press the New Page “&2 button.

To insert a duplicate of the current page:
Press the Copy Page ‘& putton.

To print the current page:
Press the Print Page & putton.

To maximize or minimize the mimio Notebook:
Press the Minimize/Maximize Window @» button.
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5.4. Storing and downloading digital ink from your mimio Xi

Your mimio Xi can be used to record Digital Ink while disconnected from your PC. All digital ink
recorded while offline can be downloaded to a mimio Notebook for printing, distribution or editing.
When running offline your mimio Xi can be powered by battery or an optionally available wall power

supply.

To record and store digital Ink:

1. Power the mimio Xi using batteries or a wall power supply.

2. If using battery power, press the Power €& putton until it turns green.

3. Use the mimio Stylus pens and eraser to record digital ink.

4. Use the mimio hardware New Page "' and Copy Page & buttons to create pages.
5

If using battery power, press the Power ®& button again to turn off the mimio Xi when done.

To download digital ink:

1. Connect the mimio Xi to your PC.
2. Do one of the following;:

e If configured to automatically download digital ink (default), open a new mimio Notebook. The

ink download process will begin automatically.
e If configured to manually download digital ink, open a new mimio Notebook and click
Download Ink &,

Recording Digital Ink
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Chapter 6: Using the mimio Notebook

Read this section to learn how to use the
mimio Notebook to create and present
content.

6.1. Working with mimio Notebooks

The mimio Notebook allows you to create and present information. Using mimio Notebook is very
similar to using other word processing or presentation applications. Content created in mimio
Notebooks can be saved as native mimio INK files or exported to a variety of other file formats including
HTML, JPEG, PNG, GIF, BMP, TIFF, and PDF.

To open a mimio Notebook:

Do one of the following:
e Double-Click the mimio Notebook icon on the Desktop.
e Right-click mimio %7 in the notification area of the Taskbar and select mimio Notebook.

[E] mimio Motebook.
2 mimio Tools
5] mimio Recorder

Settings
Help

19 Exit

]

e C(lick Start Menu, click All Programs, click mimio, and select mimio Notebook.

@ Set Program Access and Defaults

B Windows Catalog
& windows Update

I Accessories

allPrograms B | Kt

IF) Morton Antivirus
of| @ Internct Explorer

[} mimio Recorder

To open an existing Notebook:

Do one of the following:
1. Double click the icon for a mimio file on your desktop or folder.

2. Open a new mimio Notebook and click Open (.
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To save a Notebook:
1. Click Save H.

Save As @
Savein: | 'd My Computer vl O mE-
Y .53‘/)F\oppy(ﬂ:)
< Local Disk [C))

My Recent 5 CD Drive (D:)
Documents

Desktop

My Documents

ik
58
My Computer
‘,'] I Uniiledink] v
D
MyMNetwork | Saveastypel | mimio Digal Ink ["ink) v

2. In the Save as type list, click the desired save format.
3. Click Save. When saving in a save format, other then INK, a Select Pages dialog will appear.

Select Pages E\
Page Selection
(® &ll Pages
() Current Page
(O Pages

Enter page numbers and/or page rangs
separated by commas. For example: 1,2.5-12.

Picture Size

Size: | Medium (640 ¢ 480 px) v

[ ok \[ Cancel ][ Help ]

4. Select the pages to save, by selecting All Pages, Current Pages, or Pages.
5. Select the export size for images, by selecting from the Size dropdown.

To exit a Notebook:
Click Close K.

6.2. Working with views

Pages in the mimio Notebook can be viewed, presented, and edited in three different ways. For creating
content, the Single Page view can be used to display the current page. The Single Page view is the default
view in the mimio Notebook. For browsing or manipulating multiple pages, the Multi-Page view can be
used to display all pages as a series of thumbnails.. For presenting information, the Full Screen view can
be used to fill the entire screen with the current page.

To change to the Single Page view:

Do one of the following:
e From the Multi Page view, click on the Single Page “ tab.
e From the Fullscreen view, click Close B

To change to the Multi Page View:

Do one of the following:
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e From the Single Page view, click on the Multi Page  tab.
e  From the Fullscreen view, click Close % |

To change to the Fullscreen view:
Click Fullscreen E71

6.3. Working with pages

The Notebook consists of a series of pages.

To insert new pages:

Do one of the following:
¢ Click New Page =,
e If in the Recording Mode, press the New Page “&" button on your mimio device.

To make duplicates of existing pages:

Do one of the following:
¢ From the mimio Notebook, do the following:
1. Navigate to the source page.
2. Select the Duplicate Page from the Insert menu at the top the Notebook.

e If in the Recording Mode, press the Copy Page &2 button on your mimio device.

To select pages:

1. Change to the Multi Page view.
2. Do one of the following;:
e To select a single page, click on the page.
e To select multiple pages, do one of the following:
o To select one page at a time, hold down CTRL while you click each page.
o To select pages that are close to each other, click and drag a selection rectangle over the
pages.
o To select a range of pages, click on the first page and then hold down SHIFT while you click
on the last page.
e Toselect all pages, click the Edit menu and choose Select All

To deselect pages:

Do one of the following:
¢ To deselect a single page at a time, hold down CTRL while you click each page.
e To deselect all pages, click in any empty area in the mimio Notebook.

To remove pages:

1. Select the pages to remove.
2. Click the Edit menu and choose Delete .

To import pages from another Notebook:

1. Select the pages to import from the source mimio Notebook.
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2. Click Copy %

3. Select the insert location in the target mimio Notebook.

4. Click Paste I?'T

It is also possible to import pages by dragging the pages between the source and target mimio

Notebooks.

To change the size of pages:

1. Click the File menu and choose Page Setup.

3

Page Setup...

Preview

7 =
Y t

et

Page Size

Device 72" » 48"
Width:
Height:
Units: .inc:Hes
Apply To

‘wihale Document

All new pages.

v

inches

inches

v

0K

| [ Cancel ] [

Help

]

2. To select the page size, do one of the following;:
e To choose one of the preset page sizes, click the Page Size dropdown and choose any of the
available screen or device sizes.
e To choose a custom page size, click the Page Size dropdown, choose Custom, and enter the
desired valued into the Width and Height fields.
3. To select to pages to apply the page size to, do one of the following:
e To apply the page size to the current page, click the Apply To dropdown and choose Current
Page. This option is only available from the Single Page view.
e To apply the page size to the selected pages, click the Apply To dropdown and choose Selected
Pages. This option is only available from the Multi Page view.
e To apply the page size to the all pages, click the Apply To dropdown and choose Whole

Document.

4. To apply the page size to all new pages or a connected device, do one of the following:
e To apply the page size to all new pages, check All new pages. This option is only available if no
device is connected to the mimio Notebook.
e To apply the page size to all new pages and the currently connected device, check The connected
device. This option is only available if a mimio device is connected to the mimio Notebook.

To sort pages:

1. Select the pages to sort.
2. Drag the selected pages to their new location.

To print pages:

Do one of the following:

e From the mimio Notebook, do the following:
1. (optional for the Multi Page view) Select the pages to print.
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2. Click Print &.
& print @E|

General

L& =)
Status:  Ready [ Print to fle
Location:
Comment Find Printer..
Page Range
Qal Mumber of copies: |1 (3|

() Curent Page
() Pages: !rﬁS 1 ] ]
Enter page numbers and/or page ranges @

separated by commas. For example, 15-12

I_ Print J[ Cancel ][ Apply ]

To print the current page in Recording Mode, press the Print Page & button on your mimio
device.

To change the page background:

1.

Click Insert menu and choose Change Background.

Page Background E‘
Preview Page Background

Curert Backgiound
O D¥ Mode: |Stetch v

Apply T
Current Page v

[ &l new pages.

[ ok [ cancel | [ Hep |

To change the background color, click Color.

To select a background image, do one of the following;:

1. To import a background from file, Click Image.

2. To import a background from another application or the mimio Gallery, drag the image into the
Preview area.

Select the display Mode for the new background:

a. Place - the image is placed in the top left corner of the page and is not resized.

b. Stretch — the image is resized to fill the entire page.

c. Tile - the image is tiled repeatedly to fill the entire page.

d. Center - the image is placed in the center of the page and is not resized.

To select which pages the to apply the background to, do one of the following:

e To apply the background to the current page, click the Apply To dropdown and choose Current
Page. This option is only available from the Single Page view.

e To apply the background to the selected pages, click the Apply To dropdown menu and choose
Selected Pages. This option is only available from the Multi Page view.

e To apply the background to all pages, click the Apply To dropdown and choose Whole
Document.

To apply the background to all new pages, check All new pages.
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To insert the desktop as a new page:
1. Activate the Screen Clipping tool by doing one of the following:

e From the mimio Notebook click the Insert menu and choose Screen Clipping &
e From the mimio Tools click the down arrow next to the Picture 8 and choose Screen Clipping
&
2. Click on the area titled Click here to capture this Desktop as a New Page.

7 ) b IC ‘ ernet Explorer 1
Fis Edt vee Favoites Toos Hll Click here to capture this Desktop as a New Page h

Back ~

hitp:{fwsin. nasa.govjmultimediafinagegalery/image_Feature_485.html Go

To set the zoom level for a page:

Do one of the following:
e To zoom in on the currently selected objects click Zoom In /7 on the mimio Notebook.

e To zoom in on a specific location click Zoom In # on the mimio Tools and click on the zoom
location.

e To zoom in on a specific area click Zoom In /” on the mimio Tools and drag a zoom rectangle over
the target area.

e To zoom out on the currently selected object, click Zoom Out /” on the mimio Notebook.

e To zoom out on a specific location click Zoom Out /2 on the mimio Tools and click on the zoom
location.

e To restore the page to the default zoom level click Zoom Full /° on the mimio Notebook or the
mimio Tools.

6.4. Creating Objects

The mimio Tools enable the creation of a wide variety of objects on any Notebook page.

To access the drawing tools:

1. Start the mimio Tools.
2. Click on the Draw tab.

mimio Tools

How e auz2n8 @

To draw ink:
1. Click Pen V .

mimio Tools

b[se @N-00A-T ta-

%\ %...= @

gl
»

H Yo @ aEE58 §
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2. Drag the Thickness to adjust the line width.

3. To adjust the line color do one of the following;:
e To use any of the default colors click on any color in the Color Palette.
e To use additional colors click Color Selection 2.

4. Drag to draw ink strokes.

To erase ink:
1. Click Eraser .

mimic Tools

brews | Golery | werupe |
b2 sON-HOA-T -

=
> Lee ’
v »
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2. Drag the Thickness to adjust the eraser width.
3. Drag to erase ink and highlighter strokes.

To highlight an area:
1. Click Highlighter ¢ .

mimio Tools
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2. Drag the Thickness to adjust the highlighter width.

3. To adjust the line color do one of the following;:
e To use any of the default colors click on any color in the Color Palette.
e To use additional colors click Color Selection 2.

4. Drag to highlight an area.

To draw lines:
1. Click Line \, \“1, Qﬁ, or ",

mimio Tools 5]
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2. To adjust the line type, click the arrow next to Line N, %, "%, or™ and do one of the following:
e To choose a line with no arrows, select Line N,
e To choose a line with an arrow end, select Arrow End S,
e To choose a line with an arrow head, select Arrow Start M,

e To choose a line with two arrow heads, select Arrow End B,
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3. Drag the Thickness to adjust the line width.

4. To adjust the line color, do one of the following:
e To use any of the default colors, click on any color in the Color Palette.
e To use additional colors, click Color Selection A

5. Drag to draw line.

To draw shapes:

1. To select the type of shape to draw, do one of the following:
e To choose a rectangle, click Rectangle O
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If the correct shape is not selected, click the arrow next to Polygon A0 # Q or @ and do
one of the following:

To choose an equilateral triangle, select Equilateral Triangle A
To choose a right triangle, select Right Triangle B

To choose a five point star, select Five Point Star 4

O O O O

To choose a hexagon, select Hexagon o
o To choose a pentagon, select Pentagon O
2. Drag the Thickness to adjust the line width.
3. To adjust the line color, do one of the following:
e To use any of the default colors, click on any color in the left Color Palette.
e To use additional colors, click Color Selection A,
4. To adjust the fill color, do one of the following:
e To use any of the default colors, click on any color in the right Color Palette.
e To use additional colors, click Color Selection s
5. Drag to draw shape.
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To add text:
1. Click Text T,

mimio Tools
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2. To choose the font, click the arrow next to Font and select the font.
To choose the font size, click the arrow next to Font Size and select the size.
4. To choose the desired font style, do one or more of the following:
e To bold the font, click Bold B .
e Toitalicize the font, click Italic £ .
e To underline the font, click Underline U.
5. To choose the font color, click Font Color .
6. To choose the paragraph format, do one of the following:
e To left align the font, click Left =.
e To center align the font, click Center
e Toright align the font, click Right =.
7. To create the text box, do one of the following;:
e To create a variable width text box, click and begin entering text.

@

e To create a fixed width text box, drag and begin entering text.

To import pictures:
Do one of the following:
e Click Picture i#]

e Copy images and click Paste E.
e Dragimages into the mimio Notebook.

To insert a screen clipping:
1. Activate the Screen Clipping tool, by doing one of the following:

e From the mimio Notebook click the Insert menu and choose Screen Clipping &

e From the mimio Tools click the down arrow next to the Picture {8 and choose Screen Clipping
&
3. Click and drag the rectangular selection tool around the area of interest and the selected area will
automatically dropped onto the mimio Notebook page currently open..
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6.5. Manipulating Objects

Objects on page can be moved, rotated, copied, deleted, or have their properties adjusted.

To select objects:

1. Start the mimio Tools.
2. Click on the Draw tab.

mimio Tools
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3. Click Selection b*.
4. Do one of the following:
e To select a single object, click on the object.
e To select multiple objects, do one of the following:
o To select one object at a time, hold down CTRL while you click each object.
o To select objects that are close to each other, drag a selection rectangle over the objects.
e To select all objects on a page, click the Edit menu and choose Select All.

?

e

To deselect objects:

Do one of the following:
e To deselect a single object at a time, hold down CTRL while you click each object.
o To deselect all objects, click in any empty area in the mimio Notebook.

To move objects:

1. Select the objects to move.
2. Position mouse pointer over the objects. The cursor will change to the move cursor %
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3.

Drag the objects to their new location.

To resize objects:

1.
2.
3.

Select the objects to resize.

Position the mouse pointer over one of the sizing handles. The cursor will change to resize cursor R,

To increase or decrease the size in one or more directions, drag the mouse away from or toward the
center.

-0

By

NOTE: Press and hold the SHIFT key to constraint proportions during resize.

To rotate objects:

1.

2.
3.
4

Select the objects to rotate.

Position mouse pointer over one of the rotation handle. The cursor will change to rotation cursor &,
Press the left mouse button over the one of the green rotation points.

Rotate the objects by dragging the mouse around the center of the object.
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5. To snap to one of the predefined 45° increments, move the rotate cursor and release over the
predefined rotation anchor point.

To remove objects:

1. Select the objects to remove.
2. Click the Edit menu and choose Delete <.

To reorder objects:

1. Select the objects to order.
2. Do one of the following:
e Right-click on any of the objects and select Order.
e Click the Format menu and select Order.
3. To change the order, do one of the following:
e To bring the selected objects to the front of the order, select Front =]
¢ To send the selected objects to the back of the order, select Back &,
e To step the objects forward in the order by one, select Forward Ch,
e To step the objects backward in the order by one, select Backward Ich.

To group objects:

1. Select the objects to group.

2. Do one of the following:
¢ Right-click on any of the objects and select Grouping.
e (lick the Format menu and select Grouping.

3. Click Group =)

To ungroup objects:

1. Select the objects to group.

2. Do one of the following:
¢ Right-click on any of the objects and select Grouping.
e (Click the Format menu and select Grouping.

3. Click Ungroup e
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To adjust object properties:
1. Select the objects to be adjusted.

mimio Tools
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2. Drag the Thickness to adjust the line width.

3. To adjust the line color, do one of the following;:
e To use any of the default colors, click on any color in the Color Palette.
e To use additional colors, click Color Selection A,

4. To adjust the fill color, do one of the following:
e To use any of the default colors, click on any color in the Color Palette.
e To use additional colors, click Color Selection s

To adjust text objects:

Double-click on the text object.

Select the text you wish to adjust or enter new text.

To adjust the font, click the arrow next to Font and select the font.
To adjust the font size, click the arrow next to Font Size and select the font.
To adjust the desired font style, do one or more of the following:
e Tobold the font, click Bold B .

e Toitalicize the font, click Italic £ .

e To underline the font, click Underline U.

To adjust the font color, click Font Color o

To adjust the paragraph format, do one of the following;:

e To left align the font, click Left =.

e To center align the font, click Center =

e Toright align the font, click Right =.

Gl @D

N

To import objects:

1. Select the objects to import from the source mimio Notebook.
Click Copy 1.

Select the target mimio Notebook.

Click Paste 77,

Ll N

It is also possible to import objects by dragging the pages between the source and target mimio
Notebooks.

To convert ink to text:

1. Select the objects to convert. All selected objects will be combined into one text object.
2. Do one of the following;:

e Right-click on any of the objects and select Recognize Ink Ga.

e Click the Tools menu and choose Recognize Ink Ga.
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To snap objects to grid:

1. Do one of the following to open the Grid settings dialog;:
e Right-click within the Notebook window and select Grid from the right-click menu.
e  Click the View menu and choose Grid 1.

Grid X
Snap to
Snap objects to grid
Snap objects to angles.
Grid setings
Spacing: |5 paints
[ Display giid on sereen.
[ 56t as default for all new Notebooks
[ ok ][ cancel | [ Helk |

To force objects to snap to grid, check Snap objects to grid.

To allow objects to snap to angles, check Snap objects to angles.

To adjust the spacing between grid snap locations, enter the desired value into the Spacing field.
To display a visible grid on the screen, check Display grid on screen.

To make the grid setting permanent for all new mimio Notebooks, check Set as default for all new
Notebooks.

ANl

6.6. Working with Hyperlinked Objects

Objects can have hyperlinks associated with them. These hyperlinks can open files, web pages, or simply
open a different page within a mimio Notebook. When a hyperlink is associated with the object, a link
will appear at the bottom left hand side of the object.

e W A | ]
UNITED STATES

Iy \ OF
[l
L [

To add a new hyperlink:

1. Select the objects that you wish to associate the hyperlink.
2. Do one of the following:
e Right-click on any of the objects, or on any of the control points of the bounding regions. At the
bottom of the right-click menu select Hyperlink.
e Left-click on the Insert menu at the top of mimio Notebook. At the bottom of the Insert menu,
select Hyperlink.
3. In the hyperlink dialog select what you wish the object to be linked to. If you are linking to an
external file click the Browse button or simply type in the file or web page.

Edit Hyperlink
Hyperlink

Link Tao: | Existing file or 'Web Page v

Auldress

To remove an existing hyperlink:

1. Select the objects for which you wish to remove the hyperlink.
2. Do one of the following;:
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e Right-click on any of the objects, or on any of the control points of the bounding regions. At the
bottom of the right-click menu select Hyperlink.
e Left-click on the Insert menu at the top of mimio Notebook. At the bottom of the Insert menu,
select Hyperlink.
3. In the hyperlink dialog, click the Remove Link button.

Edit Hyperlink
Hyperlink

Link Tao: | Existing file or 'Web Page v

Addess: | C:\Program Files'itual Inkmimintgallercurency

To jump to a hyperlink:

Click on the Hyperlink [£], 1ocated on the lower left corner of an object.

6.7. Adjusting the mimio Notebook Settings

The mimio Notebook Settings provides options for setting General parameters for the mimio Studio
application, default interaction Mode with mimio devices, and the treatment of Digital Ink data recorded
and stored in Local Storage on a mimio Xi device.

To access the mimio Notebook Settings:

1. Open the mimio Studio Settings.
2. Click mimio Notebook [E.

B mimio Studio Settings E‘
General
Elm
) Devi Enable audio feedhack.
evices
I% Interactive Enable smaath ink and objects.
& Nethesting Enable auto recovery.
# Pens
5 Software Updale it
) Interactive
&) Recording
Connect to available device on file new.
Connect to device when any pen is used,
Laocal Storage
Download data when local storage is detected
Clear local storage after successul download
Defaults

To adjust the general setting:

1. To adjust the use of audio feedback, check/uncheck Enable audio feedback. Use this setting if you
would like to hear audio feedback for mimio software and hardware events.

2. To adjust the use of smooth ink and objects, check/uncheck Enable smooth ink and objects. Use this
setting to enable smooth or anti-aliased ink and objects. Un-checking this item can increase the
performance of the application.

3. To enable the automatic recovery of data in the event of a crash, check Enable auto recovery. When
this setting is enabled, the mimio Notebook will save ink data to a backup file every 10 minutes.
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To startup the mimio Notebook for use with the Interactive Mode:

Check Interactive.

To startup the mimio Notebook for use with the Recording Mode:

1. Check Recording.

2. To automatically connect devices to newly opened mimio Notebooks, check Connected to available
device on file New

3. To automatically open a mimio Notebook in recording mode when a mimio Stylus pen is used, check
Connect to device when any pen is used.

To automatically download Digital Ink to a new Notebook:

Check Download data when local storage is detected.

To automatically clear Digital Ink after a successful download:

Check Clear local storage after a successful download.
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Chapter 7: Using the mimio Gallery

Read this section to learn how to
incorporate gallery content into your
mimio Notebook presentations.

7.1. Navigating the mimio Gallery

The mimio Gallery contains organized sets of backgrounds and pictures. There are four types of items in
the mimio Gallery: folders, galleries, pictures, and background.

1. Folder — A folder is used to organize galleries into groups. A folder can contain other folders

or galleries.

2. Gallery — A gallery is used to organize related backgrounds and pictures. A gallery only

contains backgrounds and pictures.

3. 4G Picture- A picture can be inserted as an object into any mimio Notebook page.
4. 4EBackground — A background can be inserted into the background of any mimio Notebook

page.

To access the mimio Gallery:

1. Start the mimio Tools.
2. Click on the Gallery tab on the mimio Tools.

mimio Tools 5]
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To navigate the mimio Gallery:

1. Click Home i to return to the top level of the gallery.
Click Up 4= to move one level up in the gallery.
Double-click folders and galleries [%)] open them.
Click Pictures 4{f to view the available pictures for a gallery.

SN
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Click Background 48 to view the available backgrounds for a gallery.
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To select gallery items:

Do one of the following:
1. To select a single gallery item, click on the gallery item.
2. To select multiple gallery items, do one of the following:
e To select one gallery item at a time, hold down CTRL while you click each gallery item.
e To select gallery items that are close to each other, drag a selection rectangle over the gallery
item.
e To select a range of gallery items, click on the first gallery item and then hold down SHIFT
while you click on the last gallery item.
3. To select all gallery items, right-click to bring up the context menu and choose Select All.

To deselect gallery items:

Do one of the following:
e To deselect a gallery item at a time, hold down CTRL while you click each gallery item.
e To deselect all gallery items, click in any empty area in the mimio Gallery.

7.2. Importing gallery items into a mimio Notebook

All content from the mimio Gallery can be directly imported into any mimio Notebook.

To import pictures into a mimio Notebook:

1. Navigate to the desired gallery.
2. Click Pictures 4% to view the available pictures for the gallery.
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3. Select the pictures to import.
4. Drag the pictures into the desired mimio Notebook.

To import backgrounds into a mimio Notebook:

1. Navigate to the desired gallery.
2. Click Backgrounds 4E to view the available backgrounds for the gallery.
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3. Select the backgrounds you wish to import.
4. Drag the selected backgrounds into the desired mimio Notebook.
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7.3. Adding custom content to the mimio Gallery

The mimio Gallery is fully expandable and modifiable, allowing users to add their own folders, galleries,
pictures, and backgrounds.

To add new folders:

1. Navigate to the desired insert location. Folder can be inserted in the top level of the gallery or in
other folders.
2. Click New Folder =.

Preview Item Information

3. Enter a name for the new folder in the Name field.
4. (optional) Click Choose Picture to select a preview picture for the new folder.

To add new galleries:

1. Navigate to the desired insert location. Galleries can be inserted in the root of the gallery or in
folders.
2. Click New Gallery (= |

Preview Item Information

L]

3. Enter a name for the new gallery in the Name field.
4. (optional) Click Choose Picture to select a preview picture for the new gallery.

To add new pictures:

1. Navigate to the desired insert location. Pictures can be inserted into the picture section of galleries.
2. Click Insert Image 3.

Preview Item Infarmation

LChoose Picture. ..

3. Enter a name for the new picture in the Name field.
4. Click Choose Picture to select the new picture.

It is also possible to insert new pictures by dragging new content into a gallery.
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To add new backgrounds:

1. Navigate to the desired insert location. Backgrounds can be inserted into the background section of

galleries.
2. Click Insert Image 3.

Preview Item Infarmation

LELER e Backoround

Mode: | place v

Choose Picture.

3. Enter a name for the new picture in the Name field.
4. Click Choose Picture to select the new background.
5. Select the display Mode for the new background:
a. Place - the image is placed in the top left corner of the page and is not resized.
b. Stretch — the image is resized to fill the entire page.
c. Tile - the image is tiled repeatedly to fill the entire page.
d. Center - the image is placed in the center of the page and is not resized.

It is also possible to insert new backgrounds by dragging new content into a gallery.

To copy existing gallery items:

1. Select gallery items to copy.
2. Do one of the following:

e Click Copy %t and then click Paste P1,
e Hold down SHIFT and drag the selected gallery items.

To remove gallery items:

1. Select gallery items to remove.
2. Click Delete ¥.

To sort gallery items:

1. Select gallery items to sort.
2. Drag the selected gallery items to their new location.

7.4. Working with catalog files

Entire galleries can be exported and imported into the mimio gallery using catalog files.

To export content to a catalog file:

1. Navigate to the folder section of the gallery.
2. Select the folders and galleries you wish to export.

Using the mimio Gallery
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3. Click on the drop down to the right of Catalog B and select Export Catalog 2.

Catalog Properties

Mame: | ]

Protect contents from madification (Lacked).

Cancel

4. Enter a new name for your catalog.

5. Optionally, you can click on the Protect contents from modification (Locked) option to protect the

content from being modified by users who import the gallery content.

6. Click OK.
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_J I)Private
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- IEupdater
-3123 I3 visual Studio Projects
My Computer

File pame | imic} ot v [ sae ]
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7. Enter a filename and choose a folder location to save the mimio gallery content to the specified
catalog file.

To import content from a catalog file:

1. Navigate to the desired gallery folder into which to import into.
2. Do one of the following;:

e Click on the drop down to the right of Catalog @ and select Import Catalog B8, This will insert

the content into the current folder/gallery.
e Double-click on a catalog file and it will import the gallery content into the selected gallery
folder.

It is also possible to import content by dragging a catalog file into a gallery.

Using the mimio Gallery
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Chapter 8: Using the mimio Markups

Read this section to learn how to work

with screen markups and how they can be
incorporated into Notebook presentations
and other applications.

8.1. Navigating the mimio Markups

The mimio Markups contain all screen annotations created while in the mimio Screen Markup mode.

To access the mimio Markups:
1. Start the mimio Tools.
2. Click on the Markups tab on the mimio Tools.

mimio Tools

Gallery Markups
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To select screen markups:

Do one of the following:

1. To select a single screen markup, click on the screen markup.

2. To select multiple screen markups, do one of the following:

2. To select one screen markup at a time, hold down CTRL while you click each screen markup.

3. To select screen markups that are close to each other, drag a selection rectangle over the screen
markups.

4. To select a range of screen markups, click on the first screen markup and then hold down SHIFT
while you click on the last screen markup.

3. To select all screen markups, right-click to bring up the context menu and choose Select All

To deselect screen markups:

Do one of the following:
1. To deselect a single markup at a time, hold down CTRL while you click each screen markup.
2. To deselect all screen markups, click in any empty area in the mimio Markups.
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8.2. Exporting screen markups

Screen markups can be exported from the mimio Markups directly into open Notebooks, other
applications, or even to file(s).

To export screen markups into a Notebook:

1. Select screen markups to export.
2. Do one of the following;
b. Click Import into Notebook =
Double click on the selected screen markups.

c.
d. Click Copy @, select the target Notebook, and then click Paste Pn
e. Drag the selected screen markups into the target Notebook.

To export screen markups into another application:

1. Select screen markups to export.
Do one of the following:

e Click Copy %, select the target application, and then click Paste i)
e Drag the selected screen markups into the target application.

To export screen markups to file:

1. Select the screen markups export.
Click the Save H.

Save As @E‘
My Frecent  [Z)Hy eBacks

Documents My Music
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My Computer
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3. Inthe Save as type list, click the desired save format.

To print screen markups:

1. Select the screen markups to print.
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2. Click Print &.

& print E‘E|
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(&) Current Page
) Pages HB 1
Enter page numbers and/or page ranges I ] ]

separated by commas. For example, 1,512

Prink l[ Cancel ][ Apply ]

8.3. Organizing screen markups

Screen markups can be copied, moved, and deleted from the mimio Markups. By default, screen
markups are sorted by date, with the newest markup on the left and the oldest on the right.

To copy existing screen markups:

1. Select screen markups to copy.
2. Do one of the following:

e Click Copy % and then click Paste 21
e Hold down SHIFT and drag the selected screen markups.

To remove screen markups:

1. Select screen markups to remove.
2. Click Delete .

To sort screen markups:

1. Select screen markups to sort.
2. Drag the selected screen markups to their new location.
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Chapter 9: Using mimio Text Tool

Read this section to learn how to enter text

into Notebook presentations and other 3¢
Convert A/O‘I[e S party applications.

to Text.

9.1. Working with the mimio Text Tool

The mimio Text Tool provides a set of tools for entering text into the mimio Notebook and any other 3rd
party application. The mimio Text Tool has three modes of entering text: the On-Screen Keyboard, Write
Anywhere, and Writing Pad.

The mimio Text Tool can be used with the interactive stylus in Interactive Mode. You can also use the
mimio Text Tool with your mouse or other input device while sitting at the computer screen.

The On-Screen Keyboard allows you to enter text through an on-screen keyboard application.

Write Anywhere allows you to enter text by writing anywhere on the screen. Your handwriting is
automatically converted into text and input into the current application.

Writing Pad allows you to enter text through a small on-screen writing pad. Your handwriting is
automatically converted into text and input into the current application.
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To change the Text Tool:
1. Right-click mimio Text Tool EJ & in the notification area of the Taskbar.

[# Keyboard

(S wic i |

E wiriting Pad

Help

2. Do one of the following:
e To select and enable the On-Screen Keyboard, select Keyboard.
e To select and enable Write Anywhere, select Write Anywhere -3k
e To select and enable Writing Pad, select Writing Pad.

Enabling the Text Tool

Do one of the following:
e To enable the currently selected text tool, do one of the following:
o Click Write Anywhere K, Writing Pad E or Keyboard % in the system tray.

o Click Text Tool B on the bottom row of mimio Tools.
e To enable a tool, which is not currently selected, you must change to that tool.

Disabling the Text Tool

Do one of the following:

o Click Write Anywhere 3] Writing Pad & or Keyboard [ in the notification area of the Taskbar.

e Click Text Tool B2 on the bottom row of mimio Tools.
e Close the text tool’s application window.

9.2. Using the On-Screen Keyboard

The On-Screen Keyboard allows you to enter text into applications.

To use the On-Screen Keyboard:
1. Enable the Keyboard @ text tool.

B2 On-Screen Keyboard
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2. Left-click on the window that will receive the text, bringing the window into “focus”.
3. Press the virtual keys on the on-screen keyboard, and the text will appear in the focused window
where the cursor is located. You can change the window focus at any time to redirect the text.
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9.3. Using Write Anywhere

Write Anywhere can be used to enter text by writing anywhere on the screen with the interactive stylus
in Interactive Mode. You can also use Write Anywhere with your mouse or other input device while
sitting at the computer screen.

To use Write Anywhere:
1. Enable the Write Anywhere B text tool.

[pt1

2. Left-click on the window that you wish to receive the text, bringing the window into “focus”.
3. Write anywhere on the screen. Your handwriting will automatically be converted into text and input
into the current application.
4. Use the on-screen buttons for commonly used keys:
e To use the BACKSPACE key, click Backspace +—.
e To use the ENTER key, click Enter +—
e To use the TAB key, click Tab =
To use the SPACE key, click Space .

Write Anywhere also supports gesture recognition for commonly used keys, see section 9.5.

9.4. Using Writing Pad

Writing Pad allows you to enter text through a small on-screen writing pad with the interactive stylus in
Interactive Mode. You can also use Writing Pad with your mouse or other input device while sitting at
the computer screen.

To use Writing Pad:
1. Enable the Writing Pad R text tool.

‘Writing Pad

2. Left-click on the window that you wish to receive the text, bringing the window into “focus”.
3. Write within the yellow space of Writing Pad. Your handwriting will automatically be converted into
text and input into the current application.
4. Use the on-screen buttons for commonly used keys:
e To use the BACKSPACE key, click Backspace +—.
e Touse the ENTER key, click Enter +—
e To use the TAB key, click Tab H—_H
e To use the SPACE key, click Space se.

Writing Pad also supports gesture recognition for commonly used keys, see section 9.5.
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9.5. Using Gestures

Gesture recognition allows handwritten shortcuts to be automatically recognized as commonly used
keys. Both Write Anywhere and Writing Pad support gesture recognition.

To press BACKSPACE:

Draw a line from right to left.

To press ENTER:

Draw a connected line from top to bottom and then from right to left.

L

To press TAB:

Draw a connected line from bottom to top and then from left to right.

) T —— ) 1.

1
1
1
1

L
1

|

To press SPACE:

Draw a connected line from bottom to top and then from right to left.

T ) T |

1
1
1
I
1
1

i
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Chapter 10:  Using

mimio Recorder

Read this section to learn how to use the
mimio Recorder to create movies of your
mimio presentations with support for
synchronized audio.

10.1. Working with the mimio Recorder

The mimio Recorder provides a set of tools to record your mimio interactions into an .avi movie file with

the option to record audio as well.

To open the Recorder:

Do one of the following:

e Double-Click the mimio Recorder shortcut on the Desktop.
¢ Right-click mimio = in the notification area of the Taskbar and select mimio Recorder.

1E] mimio Nokebaok
2 mimio Tooks
[E1 mimio Recorder

Settings
Help

19 Exit

=

e Click Start Menu, click All Programs, click mimio, and select mimio Recorder.

@ Set Program Access and Defaults
W Windows Catalng
& windows Update

1) Accessories

rﬁ nirmic

) Morton Antivirus
oy | @ 1mkernet Explorer
is Start [

» | B mimio Notebook k
[E, mimio Tools

[E}, mimio Recorder

e Start the mimio Tools and click Recorder =.

Using mimio Recorder

60



To save a recording;:
1. Click File and select Save H.

Save As E]@
Savein: | 'd My Computer vl O mE-
Y .53‘/)F\oppy(ﬂ:)
< Local Disk [C))

My Recent 5 CD Drive (D:)
Documents

Desktop

My Documents

—
%8
My Computer
"] I Uniiledink] v
D
MyMNetwork | Saveastypel | mimio Digal Ink ["ink) v

2. In the Save as type list, click the desired save format.
3. Click Save.

To exit the Recorder:
Click Close ﬂ

10.2. Recording a Presentation

The mimio Recorder can be used to easily record presentations using standard record, pause, stop, and
play features.

To start a new recording:

1. Open the mimio Recorder.
2. Do one of the following:
e To begin recording using the last selected recording option (Record Desktop by default), click
Record @.

e Click on the small down-arrow at the right of Record @ open up the list of recording options.
Select the appropriate recording option:
o To record the entire Desktop, select Record Desktop =
o Torecord a specific window, select Record Window &

o Torecord an area of the screen, select Record Area .

While recording, the Recorder will automatically minimize and appear in the system tray as the mimio
Recorder B icon.

To pause a recording;:

1. Click on the mimio Recorder & icon in the system tray. This will pause the current recording and
open up the mimio Recorder.

2. Do one of the follow:
e To resume recording, click Record @
e To end this recording. click Stop ||

Using mimio Recorder 61



To stop a recording;:

1. Pause the screen recording.
2. Click Stop .

To preview a recording:

1. Pause the screen recording.

2. Click Play [ This will open your default media player to preview your recorded clip. Close your
media player before starting a new recording.
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Chapter 11:  Using mimio with Microsoft® NetMeeting

Read this section to learn how to use
mimio with Microsoft NetMeeting.

11.1. Setting up mimio Studio with NetMeeting

mimio Studio is capable of automatically connecting your mimio to an open NetMeeting session. mimio
Studio and NetMeeting can be used together both in Interactive and Recording modes.

To use NetMeeting interactively:
1. Start the NetMeeting application. Consult the Microsoft NetMeeting documentation if necessary.

2. Start the mimio Studio Interactive Mode.
3. Use the mimio Stylus pen to select tools and add content directly to the NetMeeting Whiteboard.

To use NetMeeting with digital Ink:

1. Start the NetMeeting application and launch the NetMeeting Whiteboard. Consult the Microsoft
NetMeeting documentation if necessary.

2. Begin using with the mimio Stylus pens and erasers to input digital ink directly into the NetMeeting
Whiteboard.

11.2. Adjusting the NetMeeting Settings

The NetMeeting Settings allow you to enable/disable Microsoft NetMeeting support and adjust the
device associated with the NetMeeting Whiteboard.

To access the NetMeeting Settings:
1. Open the mimio Studio Settings.
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2. Click NetMeeting <.

B mimio Studio Settings E‘
[E] mimio Motebook Enable Netiesting interaction.
B mimio Recorder . D
] Devics evice: | Any Device b
@) Interactive
& C
#* Pens

5 Software Update

To enable NetMeeting interaction:
Check Enable NetMeeting Interaction.

To disable NetMeeting interaction:
Uncheck Enable NetMeeting Interaction.

To setup NetMeeting support for a particular mimio device:

Click the Device dropdown and select the mimio device to use with NetMeeting.
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Chapter 12: = Keeping current with software updates

Read this section to learn how to check for
and install software updates for mimio

Studio.

12.1. Using the software updates

The Software Updates Settings allow you to check for and install software updates for mimio Studio.

To access the software updates:

1. Open the mimio Studio Settings.
2. Click Software Update .

B mimio Studio Settings

[] mimio Motebool
E mimio Recorder
7 Devices

Software Wersion Size

% Interactive
& Nethesting
#* Pen

Total Download Size: 0 Kb

Description

Matify me when updates are available.

Check for Updates

E3

To check for software updates:

Do one of the following:

e To manually check for available updates, click Check for Updates.

e To automatically check for available updates, check Notify me when updates are available and click

OK or APPLY to save the changes.

To install software updates:
1. Check for available updates.

2. Select the updates you wish to install from the Software list of available updates.

3. Click Install.
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Chapter 13:  Tips and Troubleshooting

V4 l Most problems with mimio can be solved
: quickly by following the advice in this
chapter.

13.1. Troubleshooting your mimio Xi and mimioBoard

This section describes common mimio Xi and mimioBoard problems and how they can be solved.

If recorded digital ink appears spotty or erratic:

e Check to see if a “Wattstopper” brand motion detector is being used in the room or office. Itis
unfortunately not possible for the Wattstopper device and mimio capture device to operate
simultaneously in the same room. It is possible to replace the “Wattstopper” units with
“SensorSwitch” (http://www.sensorswitch.com/) units that are compatible with mimio devices.

o  Check to see if the mimio is exposed to direct sunlight. Direct sunlight onto the mimio can result in
the IR sensors getting "flooded" with IR and thus cause the mimio capture device to not function.
Reposition the whiteboard or the mimio out of the direct sunlight or pull down the shades or close
the blinds in the room.

13.2. Troubleshooting your mimio wireless

This section describes common mimio wireless problems and how they can be solved.

I

Learn Button

wireless @ e

Link Status
Data
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If the Link Status LED is amber:

1. Ensure the PC is powered and turned on.

2. Ensure the wireless module is plugged into an available USB port on your PC.

3. Ensure the mimio Xi capture bar is powered on and has a green power LED. If the power LED is
amber, replace the four AA batteries in the mimio Xi capture bar.

4. Move the mimio Xi with wireless module closer to the computer with the wireless receiver connected
toit.

5. Mate the wireless module and receiver by redoing the “Learning” process.

To mate the wireless module and receiver:

Power on the mimio Xi (with wireless module).

Plug the wireless receiver into an available USB port on your PC.

Using a paper clip, press the teach button on the wireless receiver to initiate the learning process.
Press the recessed learn button on the wireless module with the tip of a pen or the end of a paper clip
to complete the learning process.

L

5. The Link Status LED will start flashing amber and green while the learning process is underway.
Once the wireless module and receiver are mated, the Link Status LED will turn to a solid green color
to show that the 2 components have been paired and that a wireless connection is established.
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Chapter 14:  Copyright and Legal Information

© Copyright 2007 Sanford LP. All Rights Reserved.
mimio is a registered trademark of Virtual Ink Corporation.

Windows and NetMeeting are registered trademarks of Microsoft Corporation.
Portions of mimio Gallery © 2003-2004 www.clipart.com.

All other marks are trademarks or registered trademarks of their respective holders.
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FCC Notice (Class B)

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and the receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

e  Consult the dealer or an experienced radio/TV technician for help.

CAUTION: Changes or modifications to this equipment not expressly approved by the party responsible
for compliance could void the user ’s authority to operate this equipment.

FCC Compliance Information Statement

Product Name: mimio Xi
Product Model Number: DMA-02

This class B device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

(1) This device may not cause harmful interference, and
(2) This device must accept any interference received, including interference that may cause
undesired operation.
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FCC Notice (Class B)

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and the receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

e  Consult the dealer or an experienced radio/TV technician for help.

CAUTION: Changes or modifications to this equipment not expressly approved by the party responsible
for compliance could void the user ’s authority to operate this equipment.

FCC Compliance Information Statement

Product Name: mimioBoard
Product Model Number: DMA-03

This class B device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

(1) This device may not cause harmful interference, and
(2) This device must accept any interference received, including interference that may cause
undesired operation.
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Declaration of Conformity

Manufacturer’s Name: Virtual Ink® Corporation

Manufacturer’s Address: 150 CambridgePark Drive
Cambridge, MA 02140
USA

Declares that the product:
Product Name: mimio Xi
Model Number: DMA-02
Conforms to the following standards:

Safety: EN 60950:1992 +A1:1993 +A2:1993 +A3:1995 +A4:1997 +A11:1997
EN 60825-1:1994
EMC: EN5081-1, EN 55022, Class B (CISPR-22)

EN 50082-1, EN 50024 using:
EN 61000-4-2 (IEC 801-2), EN 61000-4-3 (IEC 801-3), EN 61000-4-4 (IEC 801-4),
EN 61000-4-5, EN 61000-4-6, EN 61000-4-11, EN V 50204

The product is in conformity with the requirements of the General Product Safety Directive (92/59/EEC),

the Low-Voltage Directive (73/23/EEC), the EMC Directive (89/336/EEC, the Machinery Directive
(89/392/EEC), and the Product Liability Directive (85/374/EEC) and amendment 1999/44/EC).
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Declaration of Conformity

Manufacturer’s Name: Virtual Ink® Corporation

Manufacturer’s Address: 150 CambridgePark Drive
Cambridge, MA 02140
USA

Declares that the product:
Product Name: mimio wireless
Model Number: DMA-02-02
Conforms to the following standards:

Safety: EN 60950:1992 +A1:1993 +A2:1993 +A3:1995 +A4:1997 +A11:1997,
EN 60825-1:1994
EMC: EN 61000-6-3:2001, EN 55022:1998, Class B (CISPR-22),
Immunity: EN 61000-6-1:2001, EN 55024:1998 + A1:2001 + A2:2002, EN 301 489-01 V1.4.1,

EN 301 489-03 V1.4.1 using:
EN 61000-4-2:1995 + A1:1998, EN 61000-4-3:1995 + A1:1998, EN 61000-4-4:1995,
EN 61000-4-5:1995, EN 61000-4-6:1996, EN 61000-4-11:1994

Radio Spectrum: EN 300 440-2 V1.1.1

The product is in conformity with the requirements of the General Product Safety Directive (92/59/EEC),
the Low-Voltage Directive (73/23/EEC), the EMC Directive (89/336/EEC, the Machinery Directive
(89/392/EEC), and the Product Liability Directive (85/374/EEC) and amendment (1999/44/EC), the R&TTE
Directive (1999/5/EC).
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End-User License Agreement
You may freely distribute this software subject to this software license agreement.

This is a legal agreement between the you, the user ("Licensee") and Virtual Ink Corporation ("Virtual
Ink") regarding the software program attached to or enclosed or otherwise associated with this software
license agreement (the "SOFTWARE"). By clicking the button below marked "Accept," by opening the
packaging of the SOFTWARE, or by installing or using the SOFTWARE, Licensee agrees to be bound by
the terms of this Software License Agreement (the "Agreement"). If Licensee does not agree to the terms
of this Agreement, then click on the button marked "Cancel" to terminate the download or install process,
and (if you have a copy) return the SOFTWARE and any accompanying items to the place from which
you obtained them for a refund.

License. Virtual Ink grants to Licensee a non-exclusive license provided under this Agreement expressly
limited to (1) use of the enclosed SOFTWARE in combination with an authorized MIMIO system
including a MIMIO capture bar and one or more MIMIO styluses and erasers, and (2) use of the
SOFTWARE to manipulate, change, edit, or otherwise alter files formed with an authorized MIMIO
system including a MIMIO capture bar and one or more MIMIO styluses and erasers.

The non-exclusive license provided under this Agreement expressly excludes (1) use of the enclosed
SOFTWARE with any capture bars, styluses, or erasers which have not been expressly authorized by
VIRTUAL INK and (2) use of the enclosed SOFTWARE to manipulate, change, edit, or otherwise alter
files formed with any capture bars, styluses, or erasers which have not been expressly authorized by
VIRTUAL INK, and (3) any other license rights not otherwise expressly granted under this Agreement.

Copy Restrictions. This SOFTWARE and documentation is protected by United States copyright laws
and international treaty provisions. Unauthorized copying of the SOFTWARE in whole or in part is
expressly forbidden. Subject to these restrictions, Licensee may (i) load the SOFTWARE onto one
computer to support authorized use, (ii) make one copy of the SOFTWARE solely for backup purposes,
provided Licensee includes all copyright and trademark notices on the back-up copy, (iii) make copies to
distribute to others, provided that (a) this license agreement and any supporting files or data are not
removed from the SOFTWARE or disabled, (b) the copies are distributed free of charge, and (c) the copies
are not distributed over a public network including the Internet. Licensee may not copy any part of the
documentation, nor modify, adapt, translate into any language, or create derivative works based on the
documentation without the prior written consent of Virtual Ink.

Ownership of the SOFTWARE. Virtual Ink retains all right, title, and interest in the SOFTWARE and
documentation (and any copy thereof), and reserves all rights not expressly granted to Licensee. This
Agreement transfers to Licensee neither title nor any proprietary or intellectual property rights to any of
the SOFTWARE or documentation, or any copyrights, patents, or trademarks, embodied or used in
connection therewith, except for the rights expressly granted herein. This Agreement is not a sale of the
original SOFTWARE or of any copy.

Use Restrictions. This SOFTWARE is licensed to Licensee for internal use only. Licensee acknowledges
that the scope of the licenses granted hereunder do not permit Licensee (and Licensee shall not allow any
third party) to: (i) decompile, disassemble, reverse engineer or attempt to reconstruct, identify or discover
any source code, underlying ideas, underlying user interface techniques or algorithms of the SOFTWARE
by any means whatever, or disclose any of the foregoing; (ii) provide, lease, lend, use for timesharing or
service bureau purposes, or otherwise use or allow others to use the SOFTWARE for the benefit of third
parties; (iii) modify, incorporate into or with other software, or create a derivative work of any part of the
SOFTWARE.
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Transfer Restrictions. Licensee shall not sublicense, transfer or assign this Agreement or any of the rights
or licenses granted under this Agreement, except in the case of a merger or sale of all or substantially all
of Licensee's assets.

Termination. Virtual Ink may terminate this Agreement in the event of breach or default by Licensee.
Upon termination Licensee will relinquish all rights under this Agreement, and must cease using the
SOFTWARE and return or destroy all copies (and partial copies) of the SOFTWARE and documentation.

Export. Licensee agrees not to allow the Virtual Ink SOFTWARE to be sent or used in any country except
in compliance with applicable U.S. laws and regulations.

Limited Warranty and Disclaimer. Virtual Ink warrants for a period of two years from the date of receipt
that (i) the SOFTWARE will perform substantially in accordance with the accompanying documentation
in material aspects and (ii) the storage media (if any) containing the SOFTWARE will be free from any
defects in materials or workmanship**. Virtual Ink's entire liability and Licensee's exclusive remedy for a
breach of the preceding limited warranties shall be, at Virtual Ink's option, either (a) return of the license
fee, or (b) providing a fix, patch, work-around, or replacement of the SOFTWARE that does not meet
such limited warranty. Any replacement will be warranted for the remainder of the original warranty
period or 90 days, whichever is longer. Some states/jurisdictions do not allow limitations on duration of
an implied warranty, so the above limitation may not apply. EXCEPT AS EXPRESSLY SET FORTH
ABOVE, NO OTHER WARRANTIES OR CONDITIONS, EITHER EXPRESS OR IMPLIED, ARE MADE
BY VIRTUAL INK WITH RESPECT TO THE SOFTWARE AND THE ACCOMPANYING
DOCUMENTATION (STATUTORY OR OTHERWISE), AND VIRTUAL INK EXPRESSLY DISCLAIMS
ALL WARRANTIES AND CONDITIONS NOT EXPRESSLY STATED HEREIN, INCLUDING BUT NOT
LIMITED TO THE IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY,
NONINFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE. VIRTUAL INK DOES NOT
WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET LICENSEES
REQUIREMENTS, BE UNINTERRUPTED OR ERROR FREE, OR THAT ALL DEFECTS IN THE
PROGRAM WILL BE CORRECTED. Licensee assumes the entire risk as to the results and performance of
the SOFTWARE. Some states/jurisdictions do not allow the exclusion of implied warranties, so the above
exclusion may not apply.

Limitation of Liability. LICENSEE AGREES THAT IN NO EVENT SHALL VIRTUAL INK OR ITS
AGENTS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL OR INCIDENTAL
DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF
BUSINESS PROFITS, BUSINESS INTERRUPTIONS, LOSS OF BUSINESS INFORMATION, OR OTHER
PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THESE VIRTUAL INK
PRODUCTS, EVEN IF VIRTUAL INK HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. Some states/jurisdictions do not allow the limitation or exclusion of incidental or
consequential damages, so the above limitations or exclusions may not apply.

Intellectual Property Right Infringement. In the event that a claim alleging infringement of an
intellectual property right arises concerning the SOFTWARE (including but not limited to patent, trade
secret, copyright or trademark rights), Virtual Ink in its sole discretion may elect to defend or settle such
claim. Virtual Ink in the event of such a claim may also in its sole discretion elect to terminate this
Agreement and all rights to use the SOFTWARE, and require the return or destruction of the
SOFTWARE, with a refund of the fees paid for use of the SOFTWARE less a reasonable allowance for use
and shipping.

Miscellaneous. If Licensee is a corporation, partnership or similar entity, then the license to the
SOFTWARE that is granted under this Agreement is expressly conditioned upon acceptance by a person
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who is authorized to sign for and bind the entity. This Agreement is the entire agreement between
Licensee and Virtual Ink with respect to the license to the SOFTWARE, and supersedes any previous oral
or written communications or documents (including, if you are obtaining an update, any agreement that
may have been included with the initial version of the SOFTWARE). This Agreement is governed by the
laws of the Commonwealth of Massachusetts, USA and by the Directive 1999/44/EC of the European
Parliament on Certain Aspects of the Sale of Consumer Goods and Associated Guarantees. This
Agreement will not be governed by the U.N. Convention on Contracts for the International Sale of Goods.
If any provision of this Agreement is found to be invalid or unenforceable, it will be enforced to the
extent permissible and the remainder of this Agreement will remain in full force and effect. Failure to
prosecute a party's rights with respect to a default hereunder will not constitute a waiver of the right to
enforce rights with respect to the same or any other breach.

Government Users. Use, reproduction, release, modification, or disclosure of this commercial computer
SOFTWARE, or of any related documentation of any kind, is restricted in accordance with FAR 12.212
and DFARS 227.7202, and further restricted by this Agreement. Virtual Ink, Inc., 150 CambridgePark
Drive, Cambridge, MA 02140, USA.

** Per EC Directives: 1985/374/EC, Amend 1998/27/EC, and 199/468/EC.
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Limited Warranty

Virtual Ink warrants that your mimio® bar and related accessories ("Hardware") will be free from defects
in materials and workmanship under normal use and service for a period of two (2) years from the date
of purchase. Your sales receipt is your proof of the date of purchase. By registering your product, you can
receive an additional 3 year extended warranty at no additional expense.

If you think you have defective Hardware, contact Virtual Ink technical support at
http://www.mimio.com/support for verification. Before returning a failed unit, you must obtain a Return
Material Authorization (RMA) number from Virtual Ink. The RMA number should be prominently
displayed on the outside of the returned package and on the accompanying packing list. Virtual Ink will
not accept any returns without an RMA number.

Virtual Ink's sole obligation and entire liability under this limited warranty shall be, at Virtual Ink's
option, either the repair or replacement of the defective Hardware, or parts thereof; provided, however,
that you are responsible for (i) the cost of transportation of the Hardware to the designated service
location, and (ii) any loss or damage to the Hardware resulting from such transportation. All exchanged
parts or Hardware replaced under this limited warranty shall become the property of Virtual Ink. The
repair part or replacement may not be new but will be in good working order.

Virtual Ink shall have no responsibility to replace the hardware if the failure of the Hardware has
resulted from accident, abuse, misuse, negligence, unauthorized modification or repair, unsuitable
physical operating environment, improper maintenance by you or failure caused by product for which
Virtual Ink is not responsible. This limited warranty does not cover software or consumable products,
such as batteries.

VIRTUAL INK AND ITS AGENTS AND SUPPLIERS DISCLAIM ALL OTHER WARRANTIES, EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF
MERCHANTABILITY, NONINFRINGEMENT AND FITNESS FOR A PARTICULAR PURPOSE. ANY
IMPLIED WARRANTIES THAT MAY BE IMPOSED BY LAW ARE LIMITED TO THE DURATION OF
THIS LIMITED WARRANTY. IN NO EVENT SHALL VIRTUAL INK OR ITS AGENTS OR SUPPLIERS
BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, SPECIAL,
INCIDENTAL, CONSEQUENTIAL, OR INDIRECT DAMAGES FOR PERSONAL INJURY, LOSS OF
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY
OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR THE INABILITY TO USE THE
HARDWARE, EVEN IF THEY HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

In the event any of the above limitations are held unenforceable, Virtual Ink's and its agents' and
suppliers' entire liability under this limited warranty shall be limited to the amount actually paid by you
for the Hardware.

Some states/jurisdictions do not allow (i) the exclusion of implied warranties, (ii) limitations on the
duration of an implied warranty, or (iii) the exclusion or limitation of liability for consequential damages,
so the above limitations or exclusions may not apply to you. This limited warranty gives you specific
legal rights and you may also have other rights which vary from state/jurisdiction to state/jurisdiction.
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